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Background	  on	  WMU	  CMS	  
 
As one of the nation's top research universities, WMU should have a website that is functional, 
transactional and interactive. WMU Web pages should meet or exceed standards and best 
practices for accessibility across the widest possible variety of platforms, browsers and devices. 
They should also meet or exceed standards and best practices for system security, secure 
transactions, and protection of personal data and identity. They should conform to broader 
University standards for communication and branding, representing WMU in the best light 
possible and reinforcing that we truly are learner centered, discovery driven and globally 
engaged. Our website should reflect our quality programs, successful students and alumni, and 
committed employees and leadership. 
 
To meet these needs, Western Michigan University is implementing a University-wide Web 
content management system, WMU CMS. This is not an out-of-the-box system, but rather one 
being built specifically for WMU from a shareware base—Drupal. 
 
Drupal is free, open-source software maintained and developed by a community of more than 
630,000 users and developers. The open-development model means that people are constantly 
working to make sure Drupal is a cutting-edge platform that supports the latest technologies the 
Web has to offer. 

Benefits	  of	  implementing	  WMU	  CMS	  
 
A Drupal developers group has been formed at WMU, drawing on our own talent to build an in-
house knowledge base to maintain and continually enhance WMU CMS. We are thus free of the 
limitations, contracted costs and vagaries of proprietary out-of-the-box CMS software. 
 
With the benefits of a global open-development community and in-house expertise, we can 
literally meet any current or future Web need at WMU—it's simply a question of priorities, time 
and money. With WMU CMS, we are not paying for packaged features we don't need, and we 
can place a dollar value on every feature or enhancement we develop. There are no hidden costs, 
and we get the system and features we need or want. 
 
WMU CMS is an enterprise content management system—a single CMS serving all the core 
academic and administrative Web needs of the University, which offers tremendous benefits and 
cost saving through economy of scale. 
 
Among the benefits of WMU CMS compared to our previous Web management system are: 
 

• Greatly enhanced system security 
• Greatly improved system performance (speed) 
• Consistent application of best practices for accessibility 
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• Consistent University branding 
• Improved quality control to ensure WMU portrays an image worthy of its place among 

the nation's fewer than 200 research universities 
• Simultaneous posting of campus emergency and weather closing announcements on 

every page in the system 
• Global responsive design compatibility for Web devices ranging from smartphones to 

large-screen monitors 
• Ability to syndicate news and events 

Drawbacks	  of	  implementing	  WMU	  CMS	  
 
The major drawback of implementing an institution-wide Web content management system is 
loss of control. One person or one group of people oversees development and testing as well as 
the addition of new system features. Departmental webmasters no longer have direct control over 
the addition of new features to their sites. Advanced programming languages (PHP, JavaScript, 
MySQL) cannot be used in WMU CMS. The system allows a limited number of very basic 
HTML tags only. 

Changing	  the	  way	  we	  manage	  the	  Web	  	  	  	  	  
 
What we frequently refer to as websites (Sindecuse Health Center website, Lee Honors College 
website) are actually sections within a website—Western Michigan University. 
 
Everything directly off the root www.wmich.edu is a section. 
Examples: 
wmich.edu/admissions (Office of Admissions) 
wmich.edu/healthcenter (Sindecuse Health Center) 
wmich.edu/music (School of Music) 
 
Everything following the section name is part of that section. 
Example: wmich.edu/admissions/visit is part of the admissions section. 
 
Since the beginning of the University's Web presence in the early 1990s, a section has been 
defined as a “Web account,” which is nothing more than a block of space on a server. It has no 
structure. The account has a name and password, and anyone who knows the account name and 
password can access the pages and make any changes they want. There is no approval system 
and virtually no way to identify who made a change—or placed malicious code, unintentionally 
or otherwise, in our website. 
 
For most sections at WMU, we have used Dreamweaver or similar Web authoring software to 
create Web pages, which requires that users—Web managers and contributors—have the 
software on their computer and know how to use it, including how to create style sheets. They 
may also need to know PHP, JavaScript, MySQL, or other programming languages. 
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The University does not formally support those users with training or technical support, and until 
the 2009 creation of the Web Governance Council, there had been no formally adopted standards 
for WMU Web pages. There were voluntary support groups, but for all intents and purposes, 
each office and department was on its own. 
 
WMU CMS also is divided into sections, but the sections have a structure. There is no Web 
authoring software required, and system users do not need to know PHP or other languages, or 
how to create style sheets, all of which are baked in the cake, an inherent part of the CMS. 
 
Only the system administrators in university relations can alter or add to the underlying code or 
change the style sheets, which is a huge improvement to system security and allows the system 
to enforce a consistent style on all pages in WMU CMS. 
 

• Users can be assigned to one or more sections with a specific role in each section. 
• System roles promote the review and approval of changes to Web pages.  
• Users login to the system via the Web using their Bronco NetID and password. 
• Users do not need to have any special software installed on their computer. 
• WMU CMS is user based, not account based. Every change made is logged in the system 

and tied to a specific person by their Bronco NetID. 
• We can determine how many staff hours are spent maintaining Web pages, and we can do 

that by individual, by department, by college or division, or across the University. 
• The system also provides apples-to-apples analytics and reports. 
• With WMU CMS, there are no hidden costs, and all comparisons use a common scale.  

How	  WMU	  CMS	  is	  being	  implemented	  
 
Due to limited resources, this is currently a coalition of the ready and willing. We are taking 
those departments who can demonstrate readiness to transition to WMU CMS (content is up to 
Web and writing standards); willingness to work university relations (patience as we navigate a 
new system and work out bugs); and staffing resources (have people in place to fill all three roles 
determined by the CMS). 
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Roles 
System administration and management for the WMU content management system reside centrally 
in the Office of University Relations in cooperation with the Office of Information Technology. 
System managers can add sections (sites) to the CMS, assign users to one or more sections, and assign 
roles to users. All system activity is logged and identified by the user's Bronco NetID.  
 
There are three roles in each section  
 
Content contributor(s) can edit existing pages, including adding or changing images and text; can 
create a news story; and can create an event. When a contributor completes changes to a page, it is 
reviewed and approved by an editor. Content contributors typically initiate requests to the section 
manager to have a page or spotlight added or removed.  
 
Editor(s) review and approve changes and additions made by content contributors. Once the editor 
approves the change, the page is immediately published. 
 
Section manager(s) can add a page to the section and is responsible for determining where the page 
belongs in the section navigation—the left-column menu of links. Typically, once the section manager 
has created the page, a content contributor is assigned to populate the page with text, images and other 
content. Section managers are also responsible for creating and publishing spotlights, the featured 
material in the right column, and for slideshows, the revolving images frequently used on section 
home pages. 
 
Skills required 
 
All three roles require attention to detail and strong writing skills. All roles require an understanding 
of and adherence to University policies and standards, as well as FERPA, the Family Educational 
Rights and Privacy Act, and other applicable laws. Desirable skills include graphic design, use of 
Adobe PhotoShop, and knowledge of very basic HTML code. 
 
Training and compliance 
 
Ongoing training will be provided in the form of both optional and mandatory sessions. Mandatory 
sessions will be offered infrequently on multiple dates and times to accommodate schedule conflicts. 
 
Failure to attend mandatory training or refusal to follow established policies and standards for WMU 
Web pages may result in removal from the system. Violations of other University policies, such as 
failure to protect the privacy of students and student records, may result in more severe disciplinary 
action. 
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Logging In 
The WMU content management system identifies users by Bronco NetID. 
 

1. Go to https://cms.wmich.edu/user and bookmark the page. We suggest putting it in your tool 
bar. 
 

2. Enter your Bronco NetID and password. 
 

 
 
If you are a first time user, and you receive an error message, "Unrecognized username or 
password," contact a CMS manager and verify that your Bronco NetID has been entered correctly in 
the system. 
 
If you have logged in before successfully and receive an error message, try entering your Bronco 
NetID and password in GoWMU or another system using Bronco NetID authentication. If the 
problem is only with WMU CMS, contact a CMS manager. If the problem is broader, contact the IT 
Help Desk at helpdesk@wmich.edu or (269) 387-4357. 
 
Off-campus access 
 
You will need to use a virtual private network, or VPN, to access WMU CMS from off campus. 
You should always use the Network Connect client application to work in WMU CMS. This will 
keep the links on the pages you create or change from updating to include the VPN code 
(,DanaInfo=cms.wmich.edu,SSL+). 
 
Complete instructions for using VPN and downloading the Network Connect client application are 
available at: 
http://www.wmich.edu/helpdesk/securityvpn 
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1. Go to vpn.wmich.edu and enter your Bronco NetID and password. 

 

 

2. Click Start in the Network Connect box all the way at the bottom. 

	  
	  

3. The first time you select the Network Connect link, Network Connect will install on your 
computer and you will see a Please wait... screen. Note: You may need to install or update 
Java. 
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4. Depending upon which operating system you are running, you may receive the below notices, 

or variations of them. Respond as indicated in red. 

	  
	  

	  
	  

5. Once the Network Connect client has been installed you are ready to work.  

6. If you see this error, it is an indication that you failed to log out from a previous connection. 
Click Continue the session. 
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7. Depending upon your operating system, you may receive the below message when you log in. 

It is OK to click Allow. 

	  



 

Using WMU's Virtual Private Network

Use of a VPN permits secure encrypted connections to Western Michigan University's network. Users who connect
remotely to University systems that contain confidential/restricted data are required by University policy to use the campus
VPN to maintain security of  University data. To access the WMU VPN, click the appropriate link below. If you wish to
bookmark the link, right-mouse-click the link as shown below and then select your browser option to add it to your
bookmarks. If you save the bookmark after you have clicked the link and gone to the site, it will store an invalid link.

vpn.wmich.edu/sis
Access, on or off-campus for self-service and/or Internet native Banner users

vpn.wmich.edu
Off-campus access for all other users

internal.vpn.wmich.edu
Wireless (on-campus) access for all other users

Configuration and other notes
Settings and error messages you may encounter

Creating, editing and deleting VPN bookmarks
Add your own bookmarks to your VPN page

 Juniper secure access supported platforms 

VPN set up on iOS mobile devices

Note: System administrators setting up computers for non-privileged users to be able to use the WMU VPN portal should
login to GoWMU and download the VPN installer from the VPN channel.

To use the VPN

After selecting the appropriate VPN link above, login using your Bronco NetID and password.1.

If you are using the VPN to remotely connect to a system that contains confidential/restricted data, or to connect to
your work desktop, click Start in the Network Connect box. Otherwise, simply select one of the other links
displayed in that box.

2.

The first time you select the Network Connect link, Network Connect client will install on your computer and you will
see a Please wait... screen.

3.

Depending upon which OS you are running, you may receive download or run the application notices. Respond
Yes or Run, depending upon which notice you receive.

4.

When the Network Connect client has been installed, you are ready to work.5.

If you receive a warning about other user sessions in progress, it means you failed to logout from a previous6.

Using WMU’s Virtual Private Network | Technology Help Desk | ... http://www.wmich.edu/helpdesk/securityvpn
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connection. Click Continue the session.

If you receive an Internet Security warning about a script from Juniper Networks that could compromise your data,
it is okay to check Remember this decision and Allow.

7.

Con!guration and other notes
External WMU network VPN and local WMU wireless VPN connection settings

Maximum idle time: 60 minutes (requires authentication to reset time)

Maximum session time: 8 hours (requires authentication to reset time)

SIS VPN

Maximum idle time: 15 minutes (requires authentication to reset time)

Maximum session time: 4 hours (requires authentication to reset time)

Pop-ups

Must be enabled for vpn.wmich.edu and internal.vpn.wmich.edu

No Network Connection selection received

If you do not receive it after you have logged in, you may have gone to vpn.wmich.edu rather than
internal.vpn.wmich.edu or you may be trying to sign in from a wired connection using a 141.218.x.x. IP address.

Creating your own VPN bookmarks

After logging in to the VPN, click the "+" sign in the upper right corner of the Web Bookmarks area.1.

Fill in the Add Web Bookmark form and click Add Bookmark.2.

Your new bookmark will be displayed whenever you log in to the VPN.3.

Editing your VPN bookmarks

To edit a bookmark, scroll down to that bookmark and click the Item Properties icon.1.

Fill out the Edit Web Bookmarks form and click Save Changes when you are finished.2.

Deleting your VPN bookmarks

To delete a bookmark, scroll down to that bookmark and click the trashcan icon.1.

VPN set up on iOS mobile devices

Visit the App store on your iOS mobile device.1.

Search for and install Junos Pulse by Juniper Networks.2.
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Run the application.3.

Create a profile for using the VPN from off campus.4.

Configuration> Edit> Add new configuration

Name: WMU wireless off campus

URL: https://vpn.wmich.edu

Save

Create a profile for using the VPN on campus.

Configuration> Edit> Add new configuration

Name: WMU wireless on campus

URL: https://wireless.vpn.wmich.edu

Save

Select appropriate profile based on location.

Junos Pulse (upper left corner)

Select Connect

Help Desk, Western Michigan University, Kalamazoo MI 49008-5206 USA | (269) 387-4357, option 1
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Basic Page - Adding and Editing Content  
Basic page is a content type in WMU CMS. It is what the name suggests, a basic page. 
 
Only the section manager can create a basic page for the section and add a link to the page in 
the section navigation (left-hand column). The section manager is also solely responsible for 
determining the page's URL and managing the URL's for the section. 
 
Once the page has been created, either the section manager or, more typically, content 
contributor can populate the page with text, images and other content. The page is not published 
until approved by an editor, who has the ability to make changes to drafts before publishing. 
 
Adding and editing content for a basic page 
 
The content contributor can edit the page title, but changes to the page title should be made 
infrequently and deliberately. The page title might be edited to correct a misspelling or make a 
major update, such as changing the year. Setting the Section is the responsibility of the section 
manager.  
 

 
 
Text, images and tables are added and edited in the field "Body." The icons at the top of the field 
are standard throughout WMU CMS for a variety of content types, including Basic Page, 
Directory Page, News Article and Webform. 
 

 
 
Once you are familiar with the icons and what they do, you can add or edit content in a variety of 
content types. 
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 2 

 
 
Bold type 
 
The first icon is used to create bold text. Highlight a section of text, click B, and the text changes 
to bold. Click B again, and the text reverts to plain type. 
 
Add and remove links  
 
The next two icons are used to add and remove links. Highlight a section of text, click the icon 
with a chain link, and a window will open. 
 

 
 
Link URL is where you enter the URL for the Web page, PDF file, etc. If the link resides on the 
main WMU Web server, do not enter "http://www.wmich.edu/" but do enter everything 
following. You do not need to enter the trailing slash: 
Example: http://www.wmich.edu/sample/about/facts should be entered as: sample/about/facts 
 
For all other pages, including wmich.edu subdomains, enter the full URL. 
Example: http://gowmu.wmich.edu 
 
For PDF files and other attached documents: Scroll down to the Attachments field and copy 
the URL of the selected document. Copying the URL: You will see a URL to the right of each 
uploaded attachment. Highlight the full URL, then do a Control + C key command (Command + 
C for Mac users), or choose Edit -> Copy from your browser toolbar. 
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 3 

 
 
 
Paste the full URL into the "Link URL" field. Once pasted, it should display as: 
https://cms.wmich.edu/sites/default/files/attachments/filename 
 

 
 
Upon page save, the CMS will automatically clean up the link, removing the 
"https://cms.wmich.edu" portion of the link, so that your attachment will be viewable from off 
campus. Additional details on attaching PDF files and other documents are available in the 
"Attaching PDF files and other documents" section of this manual. 
 
Target should be left as "not set" (the default), which allows the browser preferences set by the 
user to decide how to handle links. 
 
Title will display as a mouseover and should only be used to provide important additional 
information. Never use a title mouseover to repeat the text of a link. 
 
 
The link Join now does not need any further explanation, and it certainly doesn't need a 
mouseover that repeats "Join now." In the sentence, "Use of social media has tripled in the past 
year," in which, it is not immediately obvious what information can be found by clicking 
social media, it might be helpful to add a title, such as "WMU policy on social media." 
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Class provides several style options, including not set, which results in a standard text link. 
 

• No border is a style used for images.  
• Aside is not fully developed. It will be introduced later. 
• Urgent is a style used with text. It does not work with links. 
• Button (blue, gold, gray, green, orange, purple, red) is used to create buttons from text 

links. 
 
Buttons should be used very sparingly. The best buttons are calls to action and no more than 
three words long. Buttons should always occupy a separate line above or below associated text. 
 

   
 
Never place buttons inline in text; inline links should be plain or bold text, not buttons. 
 
Once you have entered the link URL and set all of your link options, click Insert.  
 
Remove a link by highlighting the text and clicking the missing chain link icon. 
 
Anchors  
 
Anchors are used to create link destinations within a page. Anchors are used frequently in the 
style rules in Writing for and About WMU at wmich.edu/writing/rules. The alphabet links (A-B, 
C-D, etc.) are anchors. Under athletics, (see sports) is an anchor that takes the reader to the 
listing for sports, much lower on the same page. 
 
You can also use anchors to link to desired destinations on other pages or in other sections, 
although that requires the cooperation of someone with the contributor role in the other section. 
 
Place your cursor where you want to place the anchor (destination). Click the anchor icon and a 
window will open. Enter a name for the anchor and click insert. 
 

 
 
To link to the anchor, highlight a section of text, click the icon with the chain link. 
 
If you are linking to an anchor on the same page as the link, enter a pound sign and the name of 
the anchor (#nameofanchor). 
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If you are linking to an anchor on another page, enter the URL for the page, followed by a pound 
sign and the name of the anchor (sample/about/facts#nameofanchor). 
 

Superscript and subscript  
 
The next two icons are superscript and subscript. Do not use superscript or subscript, except as 
required for scientific or mathematic notation. Do not use superscript for 1st, 2nd, 3rd, 4th, and 
always use numbers, 1, 2, 3, 4, not 1st, 2nd, 3rd, 4th for dates. (July 21, not July 21st). 
 
Special characters  
 
The omega icon leads to a table of special characters, of which, the ones you are likely to use 
most often are non-breaking space <&nbsp;> and em dash <&mdash;>. Place your cursor at the 
point where the special character is to be inserted, click the omega icon, then click the icon for 
the special charter.   
 

 
 
 

Insert/edit image  is described later and is used primarily for adding alternate text to images. 
 
Style menu 
 
The style menu duplicates the same options offered under class for links. 
 

• No border is a style used for images. If the no-border option is not selected, the system 
automatically includes a one pixel rectangular border around images.  

• Aside is not fully developed. It will be introduced later. 
• Urgent is a style used with text. It changes the text color to red. It should be used very 
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sparingly for urgent updates and warnings (The program is sold out.) 
• Button (blue, gold, gray, green, orange, purple, red) is used to create buttons from text 

links. This style should be added by selecting a class under link. 
• Clear left, clear right, clear both are used to apply floats. Detailed instructions are 

given in the next section. 
 

  
 
 
Applying floats 
	  
The editor provides clear left, right, both classes for working with floats. This is helpful if you 
want to simulate the news layout from www.wmich.edu/news.  
 
It also allows you to simulate a directory page for other types of listings. 
Example: http://wmich.edu/president/seniorstaff 
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To apply a float to a paragraph with no line breaks: Choose any portion of the paragraph, then 
click on the "p" in the gray "Path" bar, which is along the very bottom of the editor. This will 
allow you to select the whole paragraph.  
 

 
 
Once the whole paragraph is selected, choose one of the "clear float" options from the "Styles" 
menu. 
 
To apply a float to a paragraph with line breaks: You will have to go into the HTML editor, and 
find the <p> tag for the paragraph you want to float. Replace the <p> with <p class="clear-
both">, <p class="clear-left"> or <p class="clear-right">. To make it easy, choose <p 
class="clear-both"> in most cases. 
 

 
 
 
Format menu 
 
The format menu includes options for paragraph and heads h2 to h6. There is only one h1 head 
per page and the h1 is in all cases the page title. The only other heads you are likely to use are h2 
and occasionally h3. Most pages are composed entirely of an h1 head and paragraph text. 
 

Bullet list, number list, block quote  
 
Highlight a section of text and click the icon for bullet list, also called and unordered list, or for a 
numbered (or ordered) list. 
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• This is a bullet list. 
• Bullet lists are used frequently in writing for the Web. 

 
1. This is a numbered list. 
2. Numbered lists are used less frequently, mostly for step-by-step instructions. 

 
Block quote is frequently misused. The correct use of block quote style in both print and on the 
Web is for quoting long passages from another source. For example, if we were to include a 
longer passive from President Kennedy's 1963 commencement address at American University, 
we might use block quote style, which includes indentation, and in print, often includes a smaller 
font size and change of font face. 
 

So let us not be blind to our differences, but let us also direct attention to our 
common interests and the means by which those differences can be resolved. 
And if we cannot end now our differences, at least we can help make the 
world safe for diversity. For in the final analysis, our most basic common 
link is that we all inhabit this small planet. We all breathe the same air. We 
all cherish our children's futures. And we are all mortal. —John F. Kennedy, 
June 10, 1963 

 

Undo and redo   
You can undo and redo the past 10 changes. 
 
Remove formatting  by highlighting a section of text and clicking the eraser. This will 
remove most formatting imported by copying from Microsoft Word or from an existing Web 
page. It will not remove extraneous code or empty tags, such as <p>&nbsp;</p>. It will not clear 
or remove formatting applied in WMU CMS. 
 
HTML allows you to view and edit the HTML code for the page. You can do the same thing by 
clicking Disable rich-text above the upper right corner of the body text window. 
 
Cut, copy, paste  perform the same functions you are accustomed to using in word 
processing. 
 
Paste from Word  is a valuable tool for pasting content from Microsoft Word. 

1. Select all in the Microsoft document and clear formatting. 
2. Select the portion of text you want to copy and copy text. 
3. In WMU CMS, place the cursor at the point you want to insert the text. 
4. Click the paste from Word icon. 
5. Paste the text into the window and click insert. 

 
Select all, Find  perform the same functions you are accustomed to using in word 
processing.  
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Tables 
 

 
 
The next 11 icons are all used for inserting and editing tables. You can add and remove rows and 
columns, edit row and cell properties, and merge and split merged cells. 
 
Important points about tables 
 
Never import tables from an existing Web page or Word document. Create the table in WMU 
CMS. 
 
Never use tables solely to create columns or rows. 
 
Tables are highly problematic for viewing on mobile devices. Use them only when there is no 
other practical option. 
 
The following data can be presented as a table. 
 
Undergraduate 19,285 
Graduate 5,642 
Total 24,927 
 
It can also be presented as plain text, which is much better on the Web. 
 
Undergraduate: 19,285 
Graduate: 5,642 
Total: 24,927 
 
When WMU Fast Facts was migrated to the content management system, we eliminated nine 
tables. 
wmich.edu/about/facts 
 
Images 
 
Please read the separate section on images. Photographic images should be saved as .jpg files; 
image art should be saved as .png files. The system also allows .gif, but .png is preferred.  
 

Add media, Add caption  
 
To load an image 

1. Click the point in the text where you want the image inserted. This should always be at 
the beginning of a paragraph, head or bullet point. 
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2. Click the Add media icon.     
3. Browse to select an image from your computer, or select an image from the library. 
4. Choose a standard size (width) for the image or load at original size. Standard sizes 

should always be used unless there is a compelling, practical need to use a non-standard 
size. Standard sizes can be found in the Images manual. For news articles, they are 
generally: 

a. 16:9 aspect ratio, sized 560 x 315 to 1920 x 1080 (will display at 550 pixels wide, 
or full width of column 2). 

b. 3:2 aspect ratio, sized at 225 x 150 to 1620 x 1080 pixels (will display at 225 
pixels wide). 

c. 2:3 aspect ratio, sized at150 x 225 to 720 x 1080 pixels (will display at 150 pixels 
wide). 

5. Click Submit. 
6. Choose the format for your image.  

• Large will display at 550 pixels wide. 
• Medium will display at 225 pixels wide. 
• Small will display at 150 pixels wide. 
• Original will display your image at its original size.  

 
If you are going to add a caption to the photo 

1. Click the photo. 

2. Click the Add a caption to an image icon.  
3. Enter the caption. 
4. Select float right or left. If it is a full-width image, you should place the image on a 

separate line and leave the alignment "not set." (default). 
 
Alternate text 
Alternate text <alt="Description of image."> is required for all images for blind and low-vision 
readers. Alt tags should describe the image, such as, "Photo of WMU student at Bronco Bash." 
They should not be used as a caption, "Bronco Bash is Sept. 7 in Fountain Plaza." 
 
The alt tag should include any text in image art. 
 
The presence of a photo caption does not eliminate the requirement of alternate text. 
 
Inclusion of an appropriate alt tag—alternate text—cannot be enforced by the content 
management system, but their inclusion is critical for compliance with the highest standards for 
accessibility, which is one of our University's 12 shared values for all Web pages.  
 
To add alt text 

1. Click the photo again. 

2. Click the Insert/Edit Image icon  
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3. In the description field, enter the alternate text for the image. 
 
To set a float for images without a caption 

1. Click the photo. 

2. Click the insert/edit image icon  
3. In the description field, enter the alternate text for the image. 
4. Select alignment right or left. If it is a full-width image, you should place the image on a 

separate line and leave the alignment "not set." (default). 
 
 
Check your work! 
 
Spell check 
 
You can do this in most browsers (Chrome, Safari, Firefox) by right-clicking (Control + click for 
Mac users) in the Body field of an open page. Make sure you also check the spelling of the page 
Title and Menu link title. 
 
Check for commonly made mistakes 
 
Other commonly made mistakes to check for before you submit the page to your editor for 
review: 
 

• Check to make sure Western Michigan University as well as the full, formal name of 
your unit appears on as many pages as practical. 

• Proofread and edit to WMU style. Visit wmich.edu/writing for details.  

• Make sure the information is presented in the simplest, most concise manner possible. 
People scan information online. Would any information be better presented in a bulleted 
list?  

• Make sure all headings and subheads (Heading 2, Heading 3, etc.) other than the page 
title are in news case, not title case. Only the first word and proper nouns should be 
capitalized.  

• Lowercase links to other pages and PDF files, unless they are presented as a directory-
type listing or table rather than inline text. 

• Check all links and PDF files to make sure they are functional. 

• Are any links missing? 
 
Check the code 
 
To view the underlying code for the content in Column 2 of the page, click either the HTML 
button in the toolbar, or the Disable rich-text link above and to the right of the Body field: 
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Once the HTML view is enabled:  
 

• Ensure that there is no extraneous code. 

• Check to make sure <p> is not substituted with <br /><br />. 

• Double-check that you've entered alt tags for all images.  
Check links 
 
To check links, save the page and a preview page, will be displayed. Make sure you test all links 
in this preview page before sending the page to your editor for review.  
 
If you're working in cms.wmich.edu, when you test relative links, you'll be sent to 
https://cms.wmich.edu. For pages that reside in WMU CMS, this should work. For pages that 
reside on the main WMU Web server, but not in CMS, this will result in a 404 error. To test how 
those links will actually behave once the page is published and live on www.wmich.edu, delete 
the https://cms. If you still get a 404, that link is truly broken and needs to be fixed. 
 
Attaching PDF files and other documents 
 
WMU CMS allows users to attach the following types of files to any basic page: 
 
Documents 

• Portable Document Format: pdf 
• Microsoft Word: doc, docx, dot, dotx 
• Microsoft PowerPoint: ppt, pptx, pot, potx 

Images 
• png 
• gif 
• jpg 
• jpeg  

Audio 
• mp3 
• ogg 
• oga 

Video 
• mp4 
• m4v 
• webm 
• ogv  

 
To attach an approved file type to your basic page, scroll down to the "Attachments" field. 
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Choose Select media, and browse to the file you want to upload on your hard drive. After 
selecting the file, click Submit. The file should now show as an attachment. To choose a 
different document, click Select media again. To remove the document, click Remove media. 
To attach a second document, click Add another item, then Select media in the new field.  
 
Copy the URL of the selected document. You will see a URL to the right of each uploaded 
attachment. Highlight the full URL, then do a Control + C key command (Command + C for 
Mac users), or choose Edit -> Copy from your browser toolbar. 
 

 
 

 
 
Paste the full URL of the selected document into the "Link URL" field. Once pasted, it should 
display as: 
https://cms.wmich.edu/sites/default/files/attachments/filename 
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Upon page save, the CMS will automatically clean up the link, removing the 
"https://cms.wmich.edu" portion of the link, so that your attachment will be viewable from off 
campus.  
 
Target should be left as "not set" (the default), which allows the browser preferences set by the 
user to decide how to handle links. 
 
Title will display as a mouseover and should only be used to provide important additional 
information. Never use a title mouseover to repeat the text of a link. 
 
Close the Insert/Edit Link box by clicking Insert.  
 
Remove a link by highlighting the text and clicking the missing chain link icon. 
 
 
Scroll down to "Custom URL" 

 
 
Note: Only section managers should be creating custom URLS! This section is included in 
the content contributors' manual to outline the purpose of the Custom URL field and alert 
contributors of the ramifications of changing the information in the Custom URL field. If, as a 
content contributor or editor, you notice that your section manager is leaving this field blank 
regularly, you may want to remind them of the importance of creating custom URLs.  
 
Creating a custom URL is optional, but recommended. If the page title is Tutoring Opportunities 
in the Spanish section, and you want the URL to be /spanish/tutoring, you would enter tutoring 
in the custom URL field. If the field is left blank, the URL will be generated automatically using 
the page title, and the URL would be /spanish/tutoring-opportunities. 
 
Automatically generated URLs omit words such as: a, an, as, at, by, for, is, in, of, the, to. A page 
title Mission and Vision will automatically generate a URL of /mission-vision. 
 
The CMS will only allow lower case letters, numbers and hyphens in URLs. Remember, the 
best URLs consist of a single, easy-to-remember, easy-to-spell, English-language word. 
 
Why use custom URLs? 
 
In most cases, the custom URL will be shorter and, therefore, easier to publicize than the page-
title generated URL. 
 
If the page title is Facts, the automatically generated URL would be /facts. It doesn't get much 
shorter than that, but if you later rename the page Fast Facts and still leave the custom URL field 
empty, the URL will change to /fast-facts when you save and publish the page. That could 
produce broken links on other pages or 404 errors, if you have publicized the original URL. 
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If you enter facts in the custom URL field for a page titled Facts and later change the page title to 
Repairing Your Motorcycle, the URL will remain /facts. 
 
The sole advantage of the automatically generated URL is it includes all keys words in the 
page title, which may enhance search results. 
 
WMU writing style 
 
Text on all WMU web pages should conform to WMU and Associated Press styles. Please read 
both style guides carefully before submitting pages to be published. University relations may 
deny publishing or return a page to the submitter for further work in cases where a high level of 
additional editing is needed. 
 
The WMU style guide can be found online at: 
http://www.wmich.edu/writing/ 
 
More information on Associated Press style can be found at: 
http://www.apstylebook.com/ 
 
Formatting 
 
If possible, use programs like Notepad or Text Edit to create simple text instead of the coded 
output of programs such as Microsoft Word.  
 
If using Microsoft Word, select all text, click the Edit menu, then choose Clear > Clear 
Formatting to removed extraneous code before pasting text into CMS, and then use the Paste 
from Word function in CMS to paste your text. 
 
Save the page! 
 
Click the Save button at the bottom of the page or you will lose any work done since the page 
was last saved. Once you click Save, you will see a preview of the page. Also on the preview 
screen, you will have the option to either continue making edits to the draft (by clicking Edit 
Draft), or submitting the page for review (by clicking Apply next to the "Needs Review" 
dropdown menu). 
 
Submit for review 
 
To send the page to your editor for publishing, you must choose "Needs Review" from the drop-
down menu, and then click Apply. 
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Directory Pages 
 

Introduction 
Directory pages are required for academic departments and colleges and for most administrative 
offices. For many other sections, directories are not necessary and not recommended. The person 
in the upper-left position is always the head of the department. The person in the upper right 
position is always the department secretary or administrative assistant to the department head. 

Below the department head and secretary is a horizontal rule (line). Everyone else in the 
department is listed alphabetically by column. With the exception of identifying the department 
head and secretary, the directory is an alphabetical listing of people in the department. It is not an 
organizational chart. 

In the WMU content management system, the "Directory List" content type is used to create the 
departmental directory, which is automatically populated with individual directory pages, created 
using the "Directory Page" content type. 

• Only section managers can create a "Directory List" (department's full listing). 

• Only content contributors can create a "Directory Page" (individual bio pages). 

• Editors can change existing "Directory Pages."  

 

Who should be included? 
Everyone included in the department's listing in the WMU telephone directory belongs in the 
online directory. Inclusion of others, such as student employees and interns, is discouraged, but 
ultimately left to your discretion. The more you include, the more you need to maintain. 
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For section managers only 
Creating a "Directory List" 

Directory lists are dynamic pages that display a list of directory pages for a section. To create a 
departmental directory list, go to Add Content in your Dashboard, and choose Directory List. 

Section 
Choose the section in which this directory belongs. 

Title 
The title for your main directory page should be "Directory." Do not add the name of your 
section, department or anything else here. 

Show at top 
The first person shown at the top of the list should be the head of the department. The second 
person should be the department secretary or administrative assistant to the department head. To 
choose someone, start typing his or her name. When the person's full name pops up, click on it. 
If it does not pop up, their individual directory page has not yet been created.  
 
If your content contributor has not yet created individual directory pages for each person in your 
department, leave this section blank for now. Once all of the individual directory pages have 
been created, you can come back to this page and designate a person to occupy the top slot (head 
of the department) and second slot (administrative assistant).  

Subdirectory key 
For your main directory page, leave this section blank. It only applies to subdirectories (see next 
section). 

Provide a menu link 
Scroll down to Provide a menu link, and check the box.  
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In the Menu link title field, enter the name of the page as it should appear in the section menu 
(left navigation). For your main directory page, this should be "Directory." Do not add the name 
of your section, department or anything else here. 

Description 
Entering a description, or tool tip, for the menu link is optional, and should only be used to 
provide additional information.  A description generally is not needed here. 

Parent item field 
The Parent item field determines where in the hierarchy the link will reside. Here, you should 
choose your section name.  

Weight 
Per WMU Web content standards, the Directory page should be second-to-last in the section 
menu, followed by the Contact Us page. Because standards also limit the number of items in the 
main section menu to no more than 12 text links, you can assign this page a weight of 20 and 
the Contact Us page a weight of 21, and they will float to the bottom in the correct order. (Each 
link may have up to 12 sub-links, for a maximum of more than 100 links.) 

Creating subdirectories 

Sections in the WMU content management system have the option of creating subdirectories, 
which may be useful for large, multifaceted departments. The main directory includes everyone 
in the department. A subdirectory might include only faculty, or only faculty in a specialized 
area within the department. 
 
In WMU CMS, you can tag individual records so that the person's information resides in one 
place, can be updated in one place, and can be displayed automatically in multiple subdirectories. 
 
To create a subdirectory, go to Add Content in your Dashboard, and choose Directory List. 

Section 
Choose the section in which this subdirectory page belongs. 

Title 
Enter the title for your subdirectory. Example: Electronic Communication Directory. The last 
word in your subdirectory page title should be "Directory."  
 
Standards to keep in mind: 

• Page titles are title case. Cap first word and all key words. 
• Do not use abbreviations. 
• Do not use ampersands (&). 
• Do not use ALL CAPS. 
• Do not use exclamation points! 
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Show at top 
The first person shown at the top of the list should be the head of the department represented in 
the subdirectory. Example: If you were creating a subdirectory titled "Electronic Communication 
Directory," the first person shown at the top of the list should be the director of electronic 
communication. The second person should be the administrative assistant to the department 
head. If the head of the department represented in the subdirectory does not have an 
administrative assistant, leave the second line blank. 
 
To choose someone, start typing his or her name. When the person's full name pops up, click on 
it. If it does not pop up, their individual directory page has not yet been created. If your content 
contributor has not yet created individual directory pages for each person in your department, 
leave this section blank for now. Once all of the individual directory pages have been created, 
you can come back to this page and designate a person to occupy the top slot (head of the 
department) and second slot (administrative assistant).  

Subdirectory key 
To make this directory listing show a subset of the full section directory, enter the key value that 
you want to use for filtering the directory pages. The key value should be as short as possible and 
must consist of only lowercase letters or numbers with no spaces. This key value can then be 
given to your content contributor. He or she can add to the Subdirectory keys field on any 
individual directory page that you want to include in the subdirectory listing.  
 
For example, if your section was University Relations, and this was an Electronic 
Communication subdirectory, you could enter "electronic" here and on the individual directory 
pages for members of the electronic communication team. You'd then have a subdirectory 
showing only the electronic communication team members. 

 

 

 

The key value also becomes part of the URL for the subdirectory. The URL for the electronic 
communication subdirectory, for example, would be: 
wmich.edu/universityrelations/directory/electronic. 
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Provide a menu link 
Scroll down to Provide a menu link, and check the box. In the Menu link title field, enter the 
name of the page as you want it to appear in the section menu (left navigation). For 
subdirectories, this should generally match the page title. The last word in your subdirectory 
menu link should be "Directory." Example: Electronic Communication Directory. 
 
Standards to keep in mind: 

• Menu links are title case. Cap first word and all key words. 
• Do not use abbreviations. 
• Do not use ampersands (&). 
• Do not use ALL CAPS. 
• Do not use exclamation points! 

 

 

Description 
Entering a description, or tool tip, for the menu link is optional, and should only be used to 
provide additional information.  A description generally is not needed here. 

Parent item field 
The Parent item field determines where in the hierarchy the link will reside. Here, you should 
choose your main "Directory" item, since you want the subdirectory to be nested under the main 
directory page.  

Weight 
Leave this field at the default (0), so that subdirectories will be sorted alphabetically under the 
main directory page. 
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For content contributors and editors only 
Creating a "Directory Page" 

Official Name and Title section of the form 

Directory pages contain complete contact information for a person. They automatically populate 
the section's directory listing, which is created by the section manager. To create an individual 
directory page, go to Add Content in your Dashboard, and choose Directory Page. 

Section 
Choose the section in which this directory page belongs. 

Proper first name 
Enter the person's official given name. Example: Robert. Do not include Ms., Mrs., Mr., Dr. or 
any other prefixes, titles or courtesy titles. 

Preferred first name 
Enter the person's nickname or preferred given name, if it is different from the proper first name. 
Example: Bob. If the person prefers to go by his or her middle name, enter that name here as 
well as in the middle name field below. 

Middle initial or name  
Enter the person's full middle name or middle initial if they use it regularly. 

Last name 
Enter the person's last name. 

Suffix  
If the person is a junior, senior, III, IV or V, enter that here. Do not include degrees or 
certifications (Ph.D., M.D.). Examples of acceptable suffixes: Jr., Sr., III. 

Display name 
Enter the name the person would use to introduce himself or herself in public. If the person 
commonly introduces herself as Rebecca McKenna Coolidge, that's what you should use. If she 
introduces herself as Becky Coolidge, use that. Do not include Ms, Mrs., Mr., Dr., or degrees—
just the name. If this field is left blank, it will default to the proper first name and last name. 

Job title 
Enter the person's primary official job title. Do not use abbreviations and capitalize all key words 
of four or more letters. According to WMU writing style and standards, titles generally are not 
capitalized unless they precede a person's name, but directory listings are an exception to the 
rule.  
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Example: 
Professor of Political Science 
 
Relatively few people have two official titles, but if the person truly holds a dual appointment, a 
second field is available for your use. Example: Someone might be "Professor of Political 
Science" as well as "Director of the Institute for Government and Politics." 

Adding directory photos—Portrait section of the form 

Photos can be added in the Portrait section of the directory page form. The "portrait" size is 
used on individual directory pages. The "thumbnail" size is used on departmental directory 
listings and should be a tightly cropped headshot from the same photo as the portrait. Below are 
the size specifications.  
 
 

Directory images sizes 
Name Aspect ratio Display size 

(in pixels) 
Upload range for WMU CMS 

(in pixels) 
Portrait 2:3 150 x 225 150 x 225 to 720 x 1080 
Thumbnail 3:4 69 x 92 69 x 92 to 225 x 300 

 
 
Only official University publicity photos may be used on directory pages. Official publicity 
photos are those taken by the Office of University Relations or third-party photos accepted by 
university relations. University relations holds publicity photo sessions regularly throughout the 
year and electronic copies of the photos are available to faculty and staff free of charge. Call 
(269) 387-8400 for more information. 
 
A photo library with publicity photos already color corrected and properly cropped and sized will 
be available later in the WMU CMS. In the meantime, departments and offices migrating to 
WMU CMS can request prepared images by contacting the director of electronic 
communication. University relations will gather all approved photos, crop and color-correct 
them, and send them to you on a disk. All you will need to do is load them into the CMS. 
 
If no approved photo is available, a standard, shaded box should be used. In WMU CMS, the 
shaded box is automatically added when no thumbnail image is uploaded. 

Portraits 
Portraits are 150 wide by 225 pixels (2:3) with a one pixel black border and should be cropped as 
shown for consistent head size. In the WMU content management system, portraits should be 
uploaded at a 2:3 aspect ratio in the highest resolution available up to 720 x 1080 pixels. The one 
pixel black border is added automatically by CMS, so do not add this yourself, or you will end 
up with a double border. 
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Thumbnails 
Thumbnail photos are 69 wide by 92 pixels (3:4) with a one pixel black border and are used on 
department directory listings. In the WMU content management system, thumbnails should be 
uploaded at a 3:4 aspect ratio in the highest resolution available up to 225 x 300 pixels. The one 
pixel black border is added automatically by CMS, so do not add this yourself, or you will end 
up with a double border.  

Thumbnails must be color corrected, sharpened and tightly cropped to a consistent head size. 
Thumbnails are supposed to show people's faces, not their hairstyle or what they wore to get 
their picture taken. You do not need to match the photos with surgical precision, but if you do 
not take the time to come reasonably close it won't reflect well on the department or the 
University, and it will make some faculty and staff look bad. 

Phone Numbers section of the form 

Office 
Enter the person's full, 10-digit direct-dial office phone number. Enter the area code as well as 
the exchange. Example: (269) 387-XXXX. A second field is available if you'd like to enter a 
second phone number—perhaps the main office line—but always enter the direct dial first. 

Mobile 
Enter the person's full, 10-digit mobile phone number if they consent. If a person does not want 
their mobile phone number listed, leave this field blank. 

Fax 
Enter the person's full, 10-digit fax number, if applicable. If the person has no fax number, leave 
this field blank. 

Email 
Enter the person's wmich.edu email address. Only wmich.edu email addresses may be used. 
Example: firstname.lastname@wmich.edu. 

Location 
Enter the room number and building where the person's office physically resides. Enter a 
comma, then the words "Mail Stop" and the person's four-digit campus mail stop.  
 
Example: 
310E Walwood Hall, Mail Stop 5433. 

Mailing address 
Enter the person's campus mailing address. Use USPS abbreviations for both the street address 
and state. There is no punctuation in the lines for the street address or city, state and ZIP code, 
per the requirements and preferences of the U.S. Postal Service. 
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Example: 
Name of Department 
Western Michigan University 
1903 W Michigan Ave [no punctuation] 
Kalamazoo MI 49008-XXXX USA [no comma between city and state] 
 
WMU is an international university. Always include USA.  
 
For common USPS-approved abbreviations, visit:  
wmich.edu/writing/rules/addresses 

Additional Information section of the form 

This is where you can add biographical information, degrees, certifications, teaching interests, 
and research and creative interests for senior leadership and faculty. Everything is optional, but if 
you choose to include information, it must be formatted as shown below. It also must be updated 
regularly, which is why you are advised to enter additional information only for senior leadership 
and faculty members.  
 
Click the Additional Information link to expand the menu. 

Education 

Enter the person's educational background. Begin with highest degree. Enter the information 
exactly in this format: Degree, Concentration, Name of Institution, Year. Example: Ph.D., 
American History, University of Chicago, 2004. Enter only one degree per line. To add a new 
line, click the Add another item button. 

Certification 

Enter the person's major, relevant professional certifications. Begin with the most recent. Enter 
the information exactly in this format: Certification, Concentration (if applicable), Name of 
Institution, Year. Enter only one certification per line. To add a new line, click the Add another 
item button. 

Teaching interests 

Enter up to four of the person's teaching interests. These must be subject areas taught at WMU 
on regular basis. Examples: Constitutional law, 18th century British literature, thermodynamics, 
applied neurology, business ethics in a global economy. Do not expand or upon or describe the 
areas. Enter only one teaching interest per line. 

Research interests 

Enter up to three of the person's research interests. These must be research areas in which the 
person is actively engaged. Examples: standardized testing in K-12 education, carbon-capture 
technology, American Civil War diaries. Do not expand or upon or describe the areas. Enter only 
one research interest per line. 
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Creative interests 

Enter up to three of the person's creative interests. These must be creative areas in which the 
person is actively engaged. Examples: outdoor metal sculpture, playwriting, musical composition 
and arrangement. Do not expand or upon or describe the areas. Enter only one creative interest 
per line. 

Bio 

Enter a short professional summary in paragraph form. Preferred length is 250 words or less. 
This is a biographical sketch, not a vitae. This bio must be edited to conform to WMU Writing 
Style before it is published or sent for review, otherwise it may be removed. For details on WMU 
writing style, visit: 
wmich.edu/writing 

For details on using the full-text editor shown in the Bio field, see the "Adding Content" portion 
of the WMU CMS manual. 

Subdirectories 

Sections in the WMU content management system have the option of creating subdirectories, 
which may be useful for large, multifaceted departments. The main directory includes everyone 
in the department. A subdirectory might include only faculty, or only faculty in a specialized 
area within the department. In WMU CMS, you can tag individual records so that a person's 
information resides in one place, can be updated in one place, and can be displayed automatically 
in multiple subdirectories. 

 

 

Only a section manager can create a subdirectory. Once a subdirectory has been created, your 
section manager can give you the corresponding subdirectory key value. To add this person to a 
subdirectory, you enter that directory's key value into this field.  
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If you do not know which key value to enter, ask your section manager. To add this person to 
multiple subdirectories, click the Add another item button, and another field will appear.  

 

Enter only one key value per line. 

Save the page! 

Click the Save button at the bottom of the page or you will lose any work done since the page 
was last saved. Once you click Save, you will see a preview of the directory page. Also on the 
preview screen, you will have the option to either continue making edits to the draft (by clicking 
Edit Draft), or submitting the page for review (by clicking Apply next to the "Needs Review" 
dropdown menu). 

Submit for review 

To send the page to your editor for publishing, you must choose Needs Review from the drop-
down menu, and then click Apply. 
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Submitting News and Events via WMU CMS 
Introduction 
Every "news article" and "event" that you create in WMU CMS and send for review will come to 
the Office of University Relations for editing and possible publication. Please do not test these 
content types--they should not be used unless you truly mean to send an item to university 
relations for consideration for WMU News and other media. 
 
If university relations decides to publish a news article or event submitted to us, it will then 
become content in the WMU News section. We will email you to let you know when it is 
published so you can link to it from your site. 

You will also be notified if we decide to not publish a news article or event. You can then add it 
to your own section as some other content type. Example: Include it as an announcement on your 
home page or add it as a basic page. 

Constructing a news article for WMU News 
Title 

This is a headline. The headline should be limited to 60 characters, including spaces. Fewer 
than 50 characters is preferred. 
 

Example: 
Matchbox Twenty to perform on campus 

Section 

Choose the section to which this event belongs. 

Summary 

The summary must be limited to 30 words or less, and is generally a condensed version of the 
lead paragraph (see next section). You should include the who, what, when and where of an 
event story, or a summary of the news or accolade being described in any other type of story.  
 

Example: 
Multi-platinum rock band Matchbox Twenty brings its North American tour to campus with a 
concert at 7:30 p.m. Wednesday, Feb. 13, at Miller Auditorium. Singer-guitarist Phillip Phillips 
opens the show. 
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Body 

Dateline and lead paragraph 
KALAMAZOO (or city where story was written)—Lead paragraph. The lead paragraph includes 
the who, what, when, where and why of the story. If someone were to read only the lead of a 
well-written news article, they'd have all of the basic information they needed. There's no room 
for superfluous language; just state the facts. Include the full, formal name of the organization—
in this case the organization is always Western Michigan University—in the lead.  
 

Example: 
KALAMAZOO—Multi-platinum rock band Matchbox Twenty brings its North American tour 
to Western Michigan University with a concert at 7:30 p.m. Wednesday, Feb. 13, at Miller 
Auditorium. Phillip Phillips, guitarist and 2012 American Idol winner, will open the show. 

Details or body of article 
The remainder of the article serves to back up whatever claims were made in the lead paragraph 
as well as to provide additional details about the news story or event (i.e., the "how"). You can 
have anywhere from one to several paragraphs in the body; however, try not to be too long-
winded. Writing should be simple, clear and concise. 
 
Generally, your article should be between 150 words (for simple event announcements) and 
1,000 words (for major news features). The body text should conform to WMU and Associated 
Press styles (see Page 8). 
  

Example: 
Tickets range from $38 to $78 and are now available at millerauditorium.com, by calling 
(269) 387-2300 or (800) 228-9858, and by visiting the Miller Auditorium Box Office. 
 
Matchbox Twenty (Note: this would be an H2 heading in CMS.) 
 
In addition to more than 30 million records sold worldwide, Matchbox Twenty has also earned 
countless accolades, including five Grammy nominations, four American Music Award nods, 
and the 2004 People's Choice Award for Favorite Musical Group. "North," the band's fourth 
full-length studio recording and first all-new album in a decade, furthers their pop-rock sound.  
 
For more information about the band, visit matchboxtwenty.com. 
 
Phillip Phillips (Note: this would be an H2 heading in CMS.) 
 
When Phillip Phillips won the American Idol competition in 2012 he had been playing guitar 
for fewer than 10 years, having picked up the instrument from his sister's then-boyfriend as a 
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teen. He soon traded playing in an acoustic band with family members to performing for 
millions on the Idol stage and signing with a major record label. His first single, "Home," sold 
more than 275,000 downloads, making it a Billboard Hot 100 top-10 debut.  
 
For more information about Phillip Phillips, visit phillipphillips.com. 

H2 headings (optional) 
For longer pieces, it is desirable to break up the text of the body by incorporating H2 headings. 
For example, when announcing an event with a visiting speaker, a H2 heading could preface a 
paragraph containing biographical information on your speaker. When writing a news article, an 
H2 heading could be used ahead of a paragraph containing history on your topic. It is uncommon 
for articles and announcements to include more than three. (See page 2 for examples of H2 
heading use.) 

Sponsors  
Sponsors are only listed in event stories. You don't have to include a list of sponsors, but if you 
do, they should be in the second-to-last paragraph of the story. You can explain a little bit about 
the sponsors here if you wish, or include a URL for those who wish to learn more about the event 
sponsors. 
 

Example: 
Matchbox Twenty and Phillip Phillips at Miller Auditorium is presented by the Campus 
Activities Board. 

Contact information 
Contact information is always included in the last paragraph of a news article. For more 
information, visit [website] or contact [Full name of person], [title and full name of department], 
at [person's email address] or [person's full 10-digit phone number]. 
 

Example: 
For more information, visit millerauditorium.com or contact the Campus Activities Board at 
cab-president@wmich.edu or (269) 387-2112. 

Byline 

Who wrote the story? In CMS, the byline can be left blank as long as the person submitting it is 
the one who wrote it. If you are submitting it for someone else, enter the original writer's name in 
the byline field. 
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Example: 
Cara Barnes (Note: no need to type "by," the CMS system will automatically insert it.) 

General information 

Articles should be submitted approximately three weeks ahead of the event, or two weeks ahead 
of the desired date of publication (for stories not linked to an event). This gives university 
relations time to review and publish the story so that it is online one to two weeks ahead of the 
event date. Stories not linked to an event typically remain on the WMU News page two weeks 
after the date of publication. All WMU News stories are available in the news archives 
indefinitely. 

Images (optional) 

You may include images with your article or announcement. All images should conform to 
WMU's image standards for web content, found at www.wmich.edu/web/content/images. Images 
should be as large as possible up to the highest dimensions in the CMS range. You should 
include captions and alt text for every image you submit. 

Embed image in body of article 
To embed an image in the Body section of the news article: 

1. Click the point in the text where you want the image inserted. This should always be at 
the beginning of a paragraph, head or bullet point. 

2. Click the Add media icon.     
3. Browse to select an image from your computer, or select an image from the library. 
4. Choose a standard size (width) for the image or load at original size. Standard sizes 

should always be used unless there is a compelling, practical need to use a non-standard 
size. Standard sizes can be found in the Images manual. For news articles, they are 
generally: 

• 16:9 aspect ratio, sized 560 x 315 to 1920 x 1080 (will display at 550 pixels wide, 
or full width of column 2). 

• 3:2 aspect ratio, sized at 225 x 150 to 1620 x 1080 pixels (will display at 225 
pixels wide). 

• 2:3 aspect ratio, sized at150 x 225 to 720 x 1080 pixels (will display at 150 pixels 
wide). 

5. Click Submit. 
6. Choose the format for your image.  

• Large will display at 550 pixels wide. 
• Medium will display at 225 pixels wide. 
• Small will display at 150 pixels wide. 
• Original will display your image at its original size.  
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If you are going to add a caption to the photo: 
1. Click the photo. 

2. Click the Add a caption to an image icon.  
3. Enter the caption. 
4. Select float right or left. If it is a full-width image, you should place the image on a 

separate line and leave the alignment "not set." (default). 
 
Alternate text: 
 
Alternate text <alt="Description of image."> is required for all images for blind and low-vision 
readers. Alt tags should describe the image, such as, "Photo of WMU student at Bronco Bash." 
They should not be used as a caption, "Bronco Bash is Sept. 7 in Fountain Plaza." 
 
The alt tag should include any text in image art. 
 
The presence of a photo caption does not eliminate the requirement of alternate text. 
 
Inclusion of an appropriate alt tag—alternate text—cannot be enforced by the content 
management system, but their inclusion is critical for compliance with the highest standards for 
accessibility, which is one of our University's 12 shared values for all Web pages.  
 
To add alt text: 
 

1. Click the photo again. 

2. Click the Insert/Edit Image icon  
3. In the description field, enter the alternate text for the image. 

 
To set a float for images without a caption: 
 

1. Click the photo. 

2. Click the insert/edit image icon  
3. In the description field, enter the alternate text for the image. 
4. Select alignment right or left. If it is a full-width image, you should place the image on a 

separate line and leave the alignment "not set." (default). 

 

Thumbnail image 
Choose an image with a 1:1 aspect ratio, sized at 90 x 90 to 300 x 300 pixels, for the Thumbnail 
section. This photo will display at 90 x 90 pixels next to the story title and summary on the 
WMU News home page. 
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Lead image 
Choose an image with a 3:2 aspect ration, sized at 225 x 150 to 1620 x 1080 pixels, for the Lead 
Image section. This photo will display at 225 x 150 pixels when used as a lead story in WMU 
News.  

Note 
If you do not know how to embed images using WMU CMS, you may submit your artwork 
separately by email to university-relation@wmich.edu. 

Attachments 

Do NOT use this field. 

Spell check your work 

You can do this in most browsers (Chrome, Safari, Firefox) by right-clicking (Control + click for 
Mac users) in the Body field of an open page. Make sure you also check the spelling of the Title 
and Summary. 

Click save.  

Choose "Submit for Review" from the drop-down menu, and then click Apply. 

Event submissions 
Title 

The title field should include a generic description of the event type and is limited to five or six 
words.  
 

Examples: 

• Film 
• Sustainability lecture 
• Art exhibition 
• Ethics panel 
• Bronco volleyball vs. Akron 

Section 

Choose the section to which this event belongs. 
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When 

• Choose the date of the event. 
• Enter the start time of the event. 
• Make sure "All Day" and "Show End Date" fields are left unchecked. 

Add another item 

Use this button if the event spans multiple days. 

Body 

The body allows you to enter a short description of the event. It is limited to 20 words or less 
and should only include the following elements, each separated with a comma:  
 

• Title or short description of event 
• Presenter if it's a lecture or person otherwise associated with event 
• Location 
• Time 
• Admission price, ticket information or "Free" 

 
Place a period at the very end of the listing. Because of the way the CMS compiles the 
information to form the calendar entry, the description should start with a lowercased word, 
unless it's a proper noun or title. 
 

Examples: 

• "Robot and Frank," Little Theatre, 5, 7 and 9:30 p.m. Admission $5.   
 

• keynote address by Dr. John Francis, "Planetwalker," Schneider Hall, Brown 
Auditorium, 7:30 p.m. Free, light refreshments included. 

 
• "The Art of Healing: Surviving Sexual Abuse," various artists, College of Health and 

Human Services second floor gallery, 8 a.m. to 9 p.m. Free. 
 

• "Climate Change: The Greatest Moral Issue of our Times," panel discussion with Drs. 
David Karowe, Paul Clements and Ron Kramer, 2500 Knauss Hall, 4 p.m. Free. 

 
• University Arena, 7 p.m. Tickets: www.wmubroncos.com or (888) 4-WMU-TIX. 

Attachments 

Do NOT use this field. 
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For more information (optional) 

Enter a Web address where prospective attendees can find additional information on the event.  

Related news 

Do NOT use this field. 

Published examples 

Below are several published examples, combining the Titles and Descriptions from above. 
 

Examples: 

• Film - "Robot and Frank," Little Theatre, 5, 7 and 9:30 p.m. Admission $5.   
 

• Sustainability lecture - keynote address by Dr. John Francis, "Planetwalker," Schneider 
Hall, Brown Auditorium, 7:30 p.m. Free, light refreshments included. 

 
• Art exhibition - "The Art of Healing: Surviving Sexual Abuse," various artists, College 

of Health and Human Services second floor gallery, 8 a.m. to 9 p.m. Free. 
 

• Ethics panel - "Climate Change: The Greatest Moral Issue of our Times," panel 
discussion with Drs. David Karowe, Paul Clements and Ron Kramer, 2500 Knauss Hall, 
4 p.m. Free. 
 

• Bronco volleyball vs. Akron - University Arena, 7 p.m. Tickets: www.wmubroncos. 

Click save.  

Choose "Submit for Review" from the drop-down menu, and then click Apply. 

WMU writing style 
All articles and event announcements should conform to WMU and Associated Press styles. 
Please read both style guides carefully before submitting draft articles. University relations may 
deny publishing or return an article to the submitter for further work in cases where a high level 
of additional editing is needed. 
 
The WMU style guide can be found online at: 
http://www.wmich.edu/writing/ 
 
More information on Associated Press style can be found at: 
http://www.apstylebook.com/ 
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Formatting 
If possible, use programs like Notepad or Text Edit to create simple text instead of the coded 
output of programs such as Microsoft Word.  
 
If using Microsoft Word, select all text, click the Edit menu, then choose Clear > Clear 
Formatting to removed extraneous code before pasting text into CMS, and then use the Paste 
from Word function in CMS to paste your text. 

Questions 
If you have questions or need additional information, please contact: 
Cara Barnes 
Assistant Director of Electronic Communication 
Office of University Relations 
(269) 387-8435 
cara.barnes@wmich.edu 
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Images 
Image preparation 
Adobe Photoshop is the supported and recommended product for photo manipulation at WMU. 
If you do not have Photoshop on your computer, and your department cannot afford to purchase 
a license for you, the University offers free photo-editing software, GNU Image Manipulation 
Program, for your use. For details on downloading and using GIMP, visit: 
http://www.wmich.edu/helpdesk/web/gimp.html 

For the Web, image size is expressed in pixels, not inches. Web images are typically saved at 72 
dpi, but dots-per-inch is relevant only for print, not the Web. Increasing or decreasing the dots-
per-inch of a 225 x 150 pixel image will not change the file size or resolution. 

All rectangular photographic images should have a one-pixel black border. Irregularly shaped 
images and image art generally should not have a border. Do not incorporate the one-pixel 
border in the image. Both the WMU content management system and the current Dreamweaver 
template will automatically add the border, and there is a "no border" option in both. 

Zoom in! When selecting and preparing photographic images and especially when creating 
logos, buttons and other graphic designs, be mindful of how the image will look on a smartphone 
or other small display. Tightly cropped images are more compelling and bring energy to the 
page. A tightly cropped image of two students cheering at a football game has energy and 
personality and tells a story. A crowd shot is just a photo of a bunch of people. 

Alternate text <alt="Description of image."> is required for all images for blind and low-vision 
readers. Alt tags should describe the image, such as, "Photo of WMU student at Bronco Bash." 
They should not be used as a caption, "Bronco Bash is Sept. 7 in Fountain Plaza." The alt tag 
should include any text in image art. The presence of a photo caption does not eliminate the 
requirement of alternate text. 

Images may be saved in the following file types: jpeg or jpg (preferred for photographic 
images); gif (commonly used for image art); png (preferred over gif for image art). In Photoshop, 
use "Save for Web and Devices," especially for larger jpeg files. 

Image sizes 
Column 1 - No images 

Column 2 
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Standard sizes are recommended (1) to promote a consistent appearance, just as in print 
publications; (2) to promote ease of changing images without altering page layout; and (3) to 
facilitate automatic resizing of images in the WMU Content Management System. 

Billboard images 

Images for slideshows and other full-width images, referred to as "billboard" size in WMU CMS, 
should be 16:9 aspect ratio, which is full screen on most devices and monitors. 

For WMU CMS, billboard images should be uploaded at the highest resolution available 
between 560 x 315 pixels (minimum) and 1920 x 1080 pixels (maximum). The latter is HDTV 
resolution. The CMS will render the image at the resolution needed. 

 

Standard image sizes and aspect ratios 

All of recommended sizes are standard aspect ratios for still photography and video. If you 
work to these sizes, images from a variety of sources will work in your layout. 

Standard images sizes 
Name Aspect ratio Display size Upload range for WMU CMS 
Billboard 16:9 550 x 310 560 x 315 to 1920 x 1080 
Large 3:2 225 x 150 225 x 150 to 1620 x 1080 
Spotlight 3:2 135 x 90 135 x 90 to 1620 x 1080 
Medium 2:3 150 x 225 150 x 225 to 720 x 1080 
Small 1:1 90 x 90 90 x 90 to 300 x 300 
Portrait 2:3 150 x 225 150 x 225 to 720 x 1080 
Thumbnail 3:4 69 x 92 69 x 92 to 225 x 300 
Slides 16:9 550 x 310 560 x 315 to 1920 x 1080 
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In WMU CMS, image size is constrained by width. (You can do the same thing in 
Dreamweaver, set width="xxx" in the img src code.) A "medium" image will be constrained (or 
stretched) to 150 pixels wide. Standard sizes are 150 x 225 (2:3), but you can use any size image, 
and the height will scale proportionately. Images can also be uploaded in column two at 
"original" size, but as previously noted, it is preferable to use standard sizes whenever possible. 

Standard medium images and spotlights are both 3:2 aspect ratio, which means the same images 
cropped to 3:2 used for one can be used for other, provided the image is saved to a large enough 
size. 

"Portrait," Thumbnail" and "Slide" are specific images sizes and are constrained by both height 
and width. Portraits are the same dimensions as a standard medium image. Slides are the same 
dimensions as a standard billboard. Portraits and thumbnails are used in directory pages; slides 
are used in slideshows. 

Nonstandard image sizes 

Anytime the image cannot be cropped to 3:2, 2:3 or 1:1, you may use a nonstandard size. 
Common examples: 

• Image of a book or magazine cover 
• Some logos 
• Poster art 

Slideshows 

In WMU CMS, slideshow images are billboard size and should be uploaded at the highest 
resolution available up to 1920 x 1080. 

Individual billboard (full-width column two) images are constrained by width and can be 
inserted anywhere in column two, which is also true of large, medium and small images. 
Slideshow images—slides—are constrained by both height and width, and the slideshow can 
only be inserted directly below the h1 head at the top of column two. If you upload an image that 
is not 16:9, the CMS will arbitrarily crop the image to the largest 16:9 size possible. 

Slideshows are limited to a maximum of five slides, and slides can be linked to additional 
information. 

In the CMS, text can be added to images and positioned in any of the four corners of the slide. 
This is highly preferential to embedding text in the image. The real text added by the CMS can 
scale depending on the device and remain legible on the smallest display. The CMS uses 
Helvetica bold, 18 pixels, with a 24-pixel line height and a slight drop shadow for these real-text 
captions. 

Slideshows are only impressive if the individual slides are impressive. Every home page does not 
need to have a slideshow, every slideshow does not need to have five slides, and if you don't 
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have good, compelling photographs that tell a story relevant to the purpose of the page, don't do 
a slideshow. 

Directory pages 

Portraits are used on individual directory pages. Thumbnails are used on department directory 
pages and should be a tightly cropped headshot from the same photo as the portrait. Portraits are 
the same aspect ratio and size as standard medium images. In WMU CMS, a medium image is 
constrained by width only; a portrait is constrained by both width and height. Thumbnails are 
also constrained by both width and height. 

Directory images sizes 
Name Aspect ratio Display size Upload range for WMU CMS 
Portrait 2:3 150 x 225 150 x 225 to 720 x 1080 
Thumbnail 3:4 69 x 92 69 x 92 to 225 x 300 

Only official University publicity photos may be used on directory pages. Official publicity 
photos are those taken by university relations or third-party photos accepted by university 
relations. 

University relations holds publicity photo sessions regularly throughout the year and electronic 
copies of the photos are available to faculty and staff free of charge. Call (269) 387-8400 for 
more information. 

Thumbnail photos are 69 wide by 92 pixels (3:4) with a one pixel black border and are used on 
department directory pages. In the WMU content management system, thumbnails should be 
uploaded at the highest resolution available up to 225 x 300 pixels. 

Photos from a variety of sources will vary in quality, color, contrast and density, which becomes 
very obvious when they are placed side by side on a printed page or Web page. That is why only 
university relations approved publicity photos may be used. 

If no approved photo is available, a standard, shaded box should be used. In WMU CMS, the 
shaded box is automatically added when no thumbnail image is uploaded. 

 

Thumbnails must be color corrected, sharpened and tightly cropped to a consistent head size. 
Thumbnails are supposed to show people's faces, not their hairstyle or what they wore to get 
their picture taken. You do not need to match the photos with surgical precision, but if you do 



Roles: All 

 5 

not take the time to come reasonably close (see the example above) it won't reflect well on the 
department or the University, and it will make some faculty and staff look bad. 

A photo library with publicity photos already color corrected and properly cropped will be 
available later in WMU CMS. In the meantime, departments and offices migrating to WMU 
CMS can request prepared images by contacting the director of electronic communication. 

Portraits are 150 wide by 225 pixels (2:3) with a one pixel black border and should be cropped 
as shown for consistent head size. In the WMU content management system, portraits should be 
uploaded at the highest resolution available up to 720 x 1080 pixels. 

A photo library with publicity photos already color corrected and properly cropped and sized will 
be available later in the WMU CMS. In the meantime, departments and offices migrating to 
WMU CMS can request prepared images by contacting the director of electronic 
communication. 

Column 3 - Spotlight images 

Images can be up to 135 pixels wide by any height. The standard is 135 x 90 (3:2) and is 
recommended. By designing to the standard, spotlights from a variety of sources can be used and 
shared readily. Spotlights can be photographic images or graphic designs. 

Photographic images, especially photos of people, are generally more appealing than logos. 
When designing image art, such as logos and buttons, keep it simple and use text sparingly. 

Spotlight images sizes 
Name Aspect ratio Display size Upload range for WMU CMS 
Spotlight 3:2 135 x 90 135 x 90 to 1620 x 1080 

The table above offers recommended sizes for saving standard spotlight images. For WMU 
CMS, images should be uploaded at the highest resolution available, up to the maximum listed 
above. The CMS will render the image at the resolution needed by the device. For Dreamweaver, 
images should be uploaded at size (135 x 90), but save all original image files, so higher 
resolution images can be uploaded in WMU CMS. 
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Preparing photos in Adobe Photoshop 
Note: These instructions are for Photoshop 12 in Adobe Creative Suite 5. If you are using an 
older version of Photoshop, your screen and options may differ. 

Getting started 

1. Browse to the photo you wish to prepare for the Web. 
2. Right-click (Windows) or Control + click (Mac OS), and choose "Open With Adobe 

Photoshop." 
3. First check your Preferences to make sure you are working in pixels, not inches. 

• Go to: Photoshop > Preferences > Units & Rulers. 
 

 
 

• Under Rulers, choose Pixels. 
• Leave other settings at the default values and click OK. 
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4. Make sure the image is in RGB color, not CMYK. 
• Go to: Image > Mode > RGB Color. 

 

 
 

5. Open the History window for a quick and easy way to revert by backing up one or more 
steps at any time in the photo-editing process. 

• Go to: Window > History 
 

 

Crop an image using the crop tool   
1. Select the Crop tool. 
2. Set the resample preferences in the options bar. 

• To resample the image during cropping, enter values for height, width, and resolution 
in the options bar at the very top of the screen. (For CS 6, specify height and width in 
options bar, and size and resolution in drop-down menu.) 

o To select or create a resampling preset, click the triangle next to the Crop tool 
icon in the options bar. 

o To switch the height and width dimensions, click the Swaps Height And 
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Width icon (  in CS5;  in CS6). 
• This is the point at which you will want to specify the desired width and height of the 

final image. See the tables above for standard image sizes. 
• Web images are typically saved at a resolution of 72 dots per inch. 
• For this example, we will choose: 

o Width = 1620 px 
o Height = 1080 px 
o Resolution = 72 dpi 

 

 
 

3. Drag over the part of the image you want to keep to create a marquee. 
 

 
 

4. If necessary, adjust the cropping marquee: 
• To move the marquee to another position, place the pointer inside the bounding box 

and drag. 
5. If desired, set the following in the options bar at the top of the screen: 

• Crop Guide Overlay 
o It is recommended that you enable the Crop Guide Overlay and select Rule Of 

Thirds to add guides that help you place compositional elements at 1/3 
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increments. 

• Shield (drop-down in CS5;  in CS6) 
o The cropping shield shades the image area that will be deleted. It is 

recommended that you enable the crop shield, set color to black and set 
opacity to at least 75 percent. 

6. Do one of the following: 
• To complete the crop, press Enter (Windows) or Return (Mac OS), click the Commit 

button  in the options bar, or double-click inside the cropping marquee. 
• To cancel the cropping operation, press Esc or click the Cancel button  in the 

options bar. 

Color-correct an image using auto levels 

For a quick and easy color and contrast fix, use auto levels. There are two ways to auto adjust the 
levels: 
 

1. Use the shortcut: Control + L (Windows) or Command + L (Mac). 
2. Go to: Image > Adjustments > Levels. 

 

 
 

3. In the Levels menu, choose Auto and click OK. 
 
If the result of using auto levels produces an undesirable result, undo it using the History window 
to back up one step, or use the Undo key command: Control + Z (Windows); Command + Z 
(Mac). 
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Sharpen using an unsharp mask 
Sharpening can help you emphasize texture and detail, and is critical when post-processing many 
digital images. Contrary to what its name implies, the unsharp mask is one of the most common 
types of sharpening. While an unsharp mask cannot create additional detail, it can greatly 
enhance the clarity of detail by increasing how quickly image information transitions at edges. 
This results in sharper transitions and more clearly defined borders. Try adding an unsharp mask 
to your image. 
 
If it makes the edges too sharp or creates a halo effect in areas of high contrast, simply remove it 
using the History window to back up one step, or use the Undo key command: Control + Z 
(Windows); Command + Z (Mac). 
 
To apply an unsharp mask: 

1. Go to: Filter > Sharpen > Unsharp Mask. 
2. In the Unsharp Mask menu, specify the following: 

• Amount: 25% 
• Radius: 0.5 pixels 
• Threshold: 0 pixels 

 

 
 

3. Click OK. 
4. One application is generally enough, but if you desire additional sharpening, you can use 

the Control + F (Windows) or Command + F key command for subsequent applications 
of the Unsharp Mask. 
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Optimize an image for the Web 

1. Choose File > Save For Web & Devices (Save for Web... in CS6). 
 
 
 

 
 
 
 

• Most of the default optimization settings will be fine for our use. 
• Alternately, you may set individual optimization options until you are satisfied with 

the balance of image quality and file size. The available options change depending on 
the file format you select. 

• Images may be saved in the following file types: jpeg, which is preferred for 
photographic images; gif, which is commonly used for graphics such as logos; or png, 
which is preferred over gif for graphics such as logos. 

• For photos, it is generally recommended to set the file format to JPEG, set the quality 
to Very High (80), and leave the rest of the optimization settings at default. 

• Make sure the box next to Optimized is checked. 
• Click Save. 
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2. Give the file a name. 
• Standard WMU naming conventions include: 

o Do not use blank spaces, underscores, or special characters in file or folder 
names. 

o Use lowercase for all file and folder names. 
o Use a single, relevant, easy to spell, easy to remember, easy to market, 

English language word. In those cases in which a single word is not practical, 
multiple words may be used. 

o Keep the file name as short as possible and avoid hyphenation unless absence 
of hyphenation produces an undesirable combination. Example: wmusign. 

• Include a hyphen, and the photo size from Charts A, B and C above (billboard, large, 
medium, small, spotlight, thumbnail or portrait). Example: wmusign-large. 

3. Click Save. 
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10 Common WMU Writing Style Errors 
 

1. Capitalization 
Except for the first word in a sentence, the only words that should be capitalized in text are proper nouns 
(Kalamazoo); proper adjectives (American history); common nouns only when used as part of a proper 
name (Bernhard Center, but center when used alone); and a person's title only when it precedes the 
person's name (President John Dunn, but president if used alone). 

Capitalize: Lee Honors College 
Do not capitalize: college, honors college, honors program, honors students 

Except for languages (Spanish), academic disciplines are not proper nouns and are not capitalized, 
including references to major and minor fields of study. (She earned degrees in chemistry and German.)  

Do not capitalize names of seasons, including references such as fall semester. 

Do not capitalize alumni, parents, students, faculty, staff, emeriti, directors or trustees. 

Capitalize all key words in the titles of books, plays, movies, TV shows, songs and lectures.  

2. Ampersands 
Do not use ampersands (&) in text (tuition and fees), titles (provost and vice president for academic 
affairs) or names (College of Arts and Sciences). 

3. ALL CAPS 
Do not use ALL CAPS, except for abbreviations and acronyms. 

4. Abbreviations 
Avoid abbreviations and acronyms to the greatest extent practical. Always identify programs, 
organizations and associations by their full names in the first reference, and on the Web, that means on 
every page. 

Use words (the committee, association, office, program) instead of the abbreviation. 

You may use widely recognized abbreviations, such as ACT for American College Test and NCAA for 
National Collegiate Athletic Association, even on first reference, when the initials are more widely known 
than the name and the initials are used in context. (What is the median ACT score for the class?)  

You may use abbreviations for laws (FERPA, HIPAA) and financial aid programs (FAFSA), but only 
after the full name has been introduced. 

Do not include the abbreviation in parentheses (DNIAP) after the full name. 

You may use WMU, but always use the full name, Western Michigan University, in the first or second 
reference, and on the Web, that means on every page. 

Most abbreviations for WMU offices, departments and programs are homemade, unknown 
outside our University and unfamiliar to many or most of our own students, alumni, faculty and 
staff. Don't use them. Do not use SHC for Sindecuse Health Center. Use Sindecuse, the health center, 
or the center. Do not use SOM for School of Music or School of Medicine. 

You may use initials for WMU offices, departments or programs on second reference when the initials are 
widely recognized by the general public, such as HR for human resources or OT for occupational therapy.    
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In general, use periods with two-letter abbreviations (U.S., a.m., p.m.) Do not use periods with 
abbreviations of three or more letters (WMU, USA). 

5. Use email, not e-mail. 
Use email, not e-mail. Use website, not Web site. 

6. Times 
Do not use ciphers (double zeros) for times of day or whole dollar amounts. Use the program begins at 
7 p.m. and tickets are $5 (not 7:00 p.m. and $5.00). 

Use midnight and noon, not 12 a.m. and 12 p.m. 

7. Dates and days 
When used with a date (Nov. 6), abbreviate Jan., Feb., Aug., Sept., Oct., Nov., and Dec. Do not 
abbreviate March, April, May, June or July. 

Do not abbreviate days of the week (Tuesday, not Tues.) 

8. Addresses and locations 
Use standard U.S. Postal Service abbreviations, no punctuation, the nine-digit ZIP code, and for WMU 
addresses, always include USA. 

This is an address: 

Office of the President 
Western Michigan University 
1903 W Michigan Ave 
Kalamazoo MI 49008-5202 USA 

This is a location: 
3010 Seibert Administration Building, Mail Stop 5202 

9. Phone and fax numbers 
The format for phone and fax numbers is (269) 387-8400. Use parentheses around the area code and 
always include the area code. Use a hyphen between the exchange and number. The format for toll-free 
numbers is the same. Use: (800) 555-1212. Do not use 1-800-555-1212. 

10. Named buildings and programs 
Do not use the full, formal names of buildings or other entities that are named for people. Use only the 
last name. Use Miller Auditorium, not James W. Miller Auditorium. Use Waldo Library, Sangren Hall, 
Bernhard Center, Haenicke Institute, Brown Auditorium, Lee Honors College, Meader Rare Book Room, 
Walker Institute. 

On the Web home page for a named center, institute, facility or program, it is appropriate to use the full 
name on first reference in the body text. On the home page of the Lee Honors College, use Carl E and 
Winifred Lee Honors College on first reference only. 
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Common WMU Web Content Errors 
For complete Web content standards as well as electronic communication policies and resources, 
visit wmich.edu/web.  

Site names, page titles and heading (<h1> tag) 
Site name and page titles 

• Do not include in site name:  
o Center for 
o Department of 
o Division of 
o Institute for 
o Office of 
o Office of the Vice President for 

• Exceptions (do include these): 
o College of 
o School of 
o Named units 
o Those cases in which omitting "office of" would misrepresent the site. Office of 

the President is the website for the office, not the person. 
• Use only the last name of the person for units named for people. 

o Use Lee Honors College, not Carl E and Winifred Lee Honors College. 
o Use Frostic School of Art, not Gwen Frostic School of Art. 

• Do not use ampersands (&), ALL CAPS, abbreviations or initials. 

Headings (<h1> tag) 

• The heading, or <h1> tag, must match the page title exactly. 
• There should be only one <h1> tag per page. 
• Do not use ampersands (&), ALL CAPS, abbreviations or initials. 

Other considerations 

• It is acceptable and advisable to include the full, formal name on first reference in body 
text on the site's home page. 

News versus title case 
Title case (capitalize all key words of four or more letters) 

• The page title should be written in title case. 
• The <h1> tag should be written in title case. 
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• All site navigation should be written in title case. 
• Everything else, sitewide, should be written in news case. 

News case (capitalize the first word and proper nouns only) 

• Everything except the page title, <h1> tag and site navigation should be written in 
news case. This includes: 

o All other heads--h2, h3, 4  
o All bold text subheads  
o Heads and subheads in tables  
o Spotlights 
o Bulleted lists  

• Do not capitalize links to other pages or PDF files when they appear in text, unless they 
are proper nouns (Haworth College of Business, but business college). It is OK to 
capitalize them using use title case (cap all key words of four or more letters) when they 
are presented in a directory format, include screen prompts or are followed by "page." 

• Correct: Learn more about WMU's password guidelines.  
• Correct: Visit the Password Guidelines page. 

Add Western Michigan University to every page 

• The full name of the University—Western Michigan University—should appear on every 
page in your section.  

• Acceptable abbreviations may be used after the full name Western Michigan University 
has been introduced. 

• WMU is the preferred abbreviation.  
• Other acceptable abbreviations include:  

o the University 
o Western 
o Western Michigan 

• Do not use the mascot as a general reference to the University, such as Bronco course 
offerings or Bronco commencement. 

Section navigation (Column 1) 

• Column one is used for links to pages within the section, and only to pages within the 
section.  

• The section navigation should be replicated on every page in the site. 
• Column one should contain no more than 12 text links, two of which are required—Name 

of Section (home) and Contact Us. A Directory page is required of most sections. 
• Each link may have up to 12 sub-links, for a maximum of more than 100 links.  
• Column one should contain no images. 
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Eliminate all inherent code  
This only applies to those migrating content into WMU CMS from Dreamweaver. 

• Allowed HTML tags: <h2> <h3> <h4> <h5> <h6> <p> <br> <a> <strong> <cite> 
<blockquote> <code> <ul> <ol> <li> <dl> <dt> <dd> <table> <th> <tr> <td> <caption> 
<colgroup> <col> <thead> <tbody> <tfoot> <sup> <sub> <ins> <del> <div> <span> 

• Remove all other code before pasting into WMU CMS.  
• Web page addresses and e-mail addresses turn into links automatically.  
• Email addresses will be obfuscated in the page source to reduce harvesting. 

Typography 

• Do not use ampersands (&) or @ symbols. 
• Do not use ALL CAPS. 
• Do not use italic type. 
• Do not use underlined type. 
• Use bold type sparingly. 

Avoid tabs and tables 

• Tabs are not an option—there is no practical way to render them in a responsive design. 
• Tables are problematic on smartphones and other small displays, even with the 

responsive design of WMU CMS. There is no way the information can be rearranged to 
fit a smaller display without changing the meaning of the table. 

• Try presenting the information as text, bullet lists or numbered lists. 
• Use tables only when there is no other practical way to present the information. 

Images 

• To the greatest extent possible, work to the standard sizes and aspect ratios listed in the 
Images section of the Web Content Standards: 
http://www.wmich.edu/web/content/images 

Directory pages 

• Most sections should have a Directory page.  
• It should be the second-to-last link in the section menu. 
• Only official University publicity photos may be used on directory pages. Official 

publicity photos are those taken by university relations or third-party photos accepted by 
university relations. 

• University relations holds publicity photo sessions regularly throughout the year and 
electronic copies of the photos are available to faculty and staff free of charge. Contact 
Sue Beougher at sue.beougher@wmich.edu or (269) 387-8400 for more information. 
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• The Office of University Relations will gather and prepare directory photos—both 
portrait and thumbnail versions—for you. Send a list of names for everyone in your 
department to university-relations@wmich.edu. 

Contact Us forms 

• Every section must have a Contact Us page.  
• It should be the last link in the section menu. 
• Use email (one word, no hyphen), not e-mail. 
• All fields should be written in news case (cap first word and proper nouns only). 
• Additional contact information should be listed at the bottom of the form, not the top. 
• Additional contact information should follow U.S. Postal Service regulations. There is no 

punctuation in the lines for the street address or city, state and ZIP code.  
o Example:  

Office of University Relations 
1903 W Michigan Ave 
Kalamazoo MI 49008-5433 

Spotlights (Column 3) 

• Use them to link to key pages not in the section navigation. 
• Links are news case (cap first word and proper nouns).  
• The links are limited to three lines maximum. More than three is not acceptable. One or 

two is preferred. 
• Do not use ampersands (&). 
• Do not use ALL CAPS. 
• You don't have to use different spotlights on every page within a site.  

Social media icons (Column 3) 

• Social media icons go below the final spotlight in column three. 
• Only links to official social media pages are permitted on WMU websites. 
• Official social media pages must meet certain requirements and must be approved 

by the assistant director of electronic communication in the Office of University 
Relations. Send requests to university-relations@wmich.edu. 

• Only the standard social media icons should be used. 
• A Facebook icon on the Department of English website may link to a Facebook fan page 

for the Department of English, the College of Arts and Sciences, or WMU, but there can 
only be one Facebook icon for the site and it must link to the same Facebook page 
throughout the site. 
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Editing Pages in WMU CMS 
Content contributor-initiated changes 
To approve and publish changes made to existing content or new content added by a content 
contributor, go to your Dashboard, then click the Needs Review tab. Choose the page you wish 
to edit by clicking the hyperlinked title. 
 
After the page opens in your browser, click the "Edit draft" button at the top. Follow 
instructions in the "Basic Page - Adding and Editing Content" portion of the WMU CMS manual 
to make necessary edits.  
 

• Check to make sure Western Michigan University as well as the full, formal name of 
your unit appears on as many pages as practical. 

• Spell check. You can do this in most browsers (Chrome, Safari, Firefox) by right-
clicking (Control + click for Mac users) in the Body field of an open page. Make sure 
you also check the spelling of the page Title and Menu link title. 

• Proofread and edit to WMU style. Check for commonly made mistakes, which are listed 
on Page 4 of this manual. 

• Make sure the information is presented in the simplest, most concise manner possible. 
People scan information online.  

• Make sure all headings and subheads other than the page title are in news case, not title 
case. Only the first word and proper nouns should be capitalized.  

• Lowercase links to other pages and PDF files, unless they are presented as a directory-
type listing or table rather than inline text. 

 
To view the underlying code for the content in Column 2 of the page, click either the HTML 
button in the toolbar, or the Disable rich-text link above and to the right of the Body field: 
 

 
 
 
Once the HTML view is enabled:  
 

• Ensure that there is no extraneous code. 
• Check to make sure <p> is not substituted with <br /><br />. 
• Check for alt tags on images. 
• Check to make sure all links are entered properly according to instructions on Page 5 of 

this manual. 
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Scroll down to the Menu link title field. 
 

 
 
 
This is what will appear in the section menu (left-hand navigation). Make sure it is as simple and 
concise as possible. Instead of Best Midwestern High School Writing Competition, use High 
School Writing Competition. Instead of Lee Honors College Requirements or Requirements to 
Join Lee Honors College, use Requirements.  
 
Once all edits have been made, scroll all the way to the bottom of the page, and click Save.  
 
A preview of the page will display in your browser. Choose "Published" from the moderation 
drop-down menu and click the Apply button. 
 
 
 

 
 
 
The page is now published and live on the Web. 

Editor-initiated changes 
To initiate new changes as an editor, you will need to browse to the page and click the New 
Draft button at the top of the page, or go to the All Content tab in your Dashboard, and choose 
the page you wish to edit by clicking the hyperlinked title. 
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Once all changes have been made and you have saved the page, you will get a screen that looks 
like this: 
 

 
 

 
Notice that you do not have the option to publish the page immediately upon saving it. This is 
because WMU CMS requires for two people to view and approve every Web page before it goes 
live. This is to ensure a higher level of quality control than what has historically been in place at 
the University. Before you can publish your own changes, a content contributor must look at the 
page and mark it for review.  
 
As soon as an editor-initiated change is saved, the page will appear as a new draft in the Draft 
tab of your content contributor's Dashboard. He or she must review the page and send it back to 
you for final publishing. To do this, they will need to: 
 

1. Go to Dashboard. 
1. Click the Drafts tab 
2. Choose the page by clicking on its hyperlinked title. 
3. Click the View Draft button at the top of the page. 
4. Choose "Needs review" from the moderation drop-down menu and click the Apply 

button. 
 

 
 
 
The page will now come back to you, the editor. You can now proceed with publishing. Find the 
page in your Needs Review section of the Dashboard, or browse directly to it. A preview of the 
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page will display in your browser. Click the View draft button; choose "Publish" from the 
moderation drop-down menu; and click the Apply button. 
 

 
 

Commonly made mistakes 
To be double-checked before publishing 
 

1. Add "Western Michigan University" as well as full, formal name of unit on first 
reference whenever practical. 

2. Check for extraneous code. 
3. Check for <p>; should not be substituted with <br /><br /> 
4. Proofread and edit to WMU style. Check for commonly made mistakes. 
5. Spell check. You can do this in most browsers (Chrome, Safari, Firefox) by right-

clicking (Control + click for Mac users) in the Body field of an open page. Make sure 
you also check the spelling of the page Title and Menu link title. 

6. Should section menu item be shortened? 
7. Would any information be better presented in a bulleted list?  
8. Make sure all H2s and H3s are in NEWS CASE, not title case. 
9. Lowercase links to other pages and PDF files, unless they are presented as a 

directory-type listing rather than in text. 
10. Check Spotlights: Good image? News case? Functional? 
11. Check for alt tags on images 
12. Directory pages 

a. Official headshot from University Relations? 
13. Check all links and PDF files to make sure they are functional. See Page 6 for 

detailed notes on checking links. 
14. Are any links missing? 
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Notes on creating links 
To add or remove a link, highlight a section of text, click the icon with a chain link, and a 
window will open. 
 

 
 
Link URL is where you enter the URL for the Web page, PDF file, etc.  
 
If the link resides on the main WMU Web server: Do not enter "http://www.wmich.edu/" but do 
enter everything following. You do not need to enter the trailing slash: 
Example: http://www.wmich.edu/sample/about/facts should be entered as:  
sample/about/facts 
 
For all other pages, including wmich.edu subdomains: Enter the full URL. 
Example: http://gowmu.wmich.edu 
 
For PDF files and other attached documents: Scroll down to the Attachments field and copy 
the URL of the selected document. Copying the URL: You will see a URL to the right of each 
uploaded attachment. Highlight the full URL, then do a Control + C key command (Command + 
C for Mac users), or choose Edit -> Copy from your browser toolbar. 
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Paste the full URL into the "Link URL" field. Once pasted, it should display as: 
https://cms.wmich.edu/sites/default/files/attachments/filename 
 

 
 
Upon page save, the CMS will automatically clean up the link, removing the 
"https://cms.wmich.edu" portion of the link, so that your attachment will be viewable from off 
campus.  
 

Notes on checking links 
To check links, save the page and a preview page, will be displayed. Make sure you test all links 
in this preview page before publishing a page.  
 
If you're working in cms.wmich.edu, when you test relative links, you'll be sent to 
https://cms.wmich.edu. For pages that reside in WMU CMS, this should work. For pages that 
reside on the main WMU Web server, but not in CMS, this will result in a 404 error. To test how 
those links will actually behave once the page is published and live on the main www.wmich.edu 
server, delete the https://cms. If you still get a 404, that link is truly broken and needs to be fixed. 


